USER GUIDE

Tolomatic Motion Interface (TMI)

Actuator Control Solutions for:

• ACS Stepper Drive/Controller
• Tolomatic Electric Linear Actuators
Tolomatic reserves the right to change the design or operation of the equipment described herein and any associated motion products without notice. Information in this document is subject to change without notice.
## Contents

1 **Host Computer Requirements** .............................................................. 1_1  
   1.1 Host Computer and Software System Requirements ............... 1_1  
      1.1.1 Hardware Requirements ............................................. 1_1  
      1.1.2 Operating Systems Supported .................................. 1_1  

2 **Installing the Tolomatic Motion Interface (TMI) Software** .......... 2_1  
   2.1 Installation Instructions .................................................. 2_1  
      2.1.1 Installing from the Tolomatic CD .................................. 2_1  
      2.1.2 Downloading and Installing from the Tolomatic Web Site at www.tolomatic.com .................................................. 2_1  

3 **Starting the TMI Software** ............................................................. 3_1  
   3.1 Launching the TMI Software .............................................. 3_1  

4 **Establishing Communication** ...................................................... 4_1  
   4.1 Establishing Communication with the Tolomatic Drive .......... 4_1  

5 **Navigating through the TMI Software** ........................................... 5_1  
   5.1 Navigating through the Tolomatic Motion Interface (TMI) ....... 5_1  
      5.1.1 Setup Wizard Tabs .................................................. 5_1  
      5.1.2 Tolomatic Logo ...................................................... 5_1  
      5.1.3 Tool Bar .............................................................. 5_2  
      5.1.4 Tool Tips .............................................................. 5_3  
      5.1.5 Parameter Entry ..................................................... 5_4  
      5.1.6 File Menu ............................................................. 5_4  
      5.1.7 Tools Menu ........................................................... 5_5  
      5.1.8 Help Menu ............................................................ 5_6  

6 **The Actuator Tab** ........................................................................ 6_1  
   6.1 Using the Actuator Tab ...................................................... 6_1  
      6.1.1 Tolomatic Actuator Selection ...................................... 6_1  
      6.1.2 Other Actuator Selection .......................................... 6_1  

7 **The Motor Tab** ........................................................................... 7_1  
   7.1 Using the Motor Tab ........................................................ 7_1  
      7.1.1 Tolomatic Motor Selection ........................................ 7_1  
      7.1.2 Other Motor Selection .............................................. 7_1  

8 **The Mode Select Tab** ................................................................. 8_1  
   8.1 Using the Mode Select Tab ............................................... 8_1  

9 **The I/O Tab** ............................................................................... 9_1
14.1 Using the Motion Manager ............................................................. 14_1
  14.1.1 Controls ................................................................................14_1
  14.1.2 Motion Profile ........................................................................14_1
  14.1.3 Jog .......................................................................................14_1
  14.1.4 Absolute Move .......................................................................14_2
  14.1.5 Incremental Move ..................................................................14_2

15 Digital I/O Tool .................................................................................. 15_1
  15.1 Using the Digital I/O Tool ..............................................................15_1

16 Analog I/O Tool ...................................................................................16_1
  16.1 Using the Analog I/O Tool .............................................................16_1

17 Drive Status Tool ................................................................................17_1
  17.1 Using the Drive Status Tool ..........................................................17_1

18 18.1 Using the Network Setup Tool ..................................................18_1
  18.1 Using the Network Setup Tool .........................................................18_1

19 Ethernet Advanced Diagnostics ......................................................... 19_1
  19.1 Using Ethernet Advanced Diagnostics .........................................19_1

Appendix 1 ...............................................................................................A-1
  Timing Diagrams ...................................................................................A_1
  Timing Rules .........................................................................................A_2

Appendix 2 ...............................................................................................A-3
  Index Move Mode - Move Select Logic Table .......................................A_3

Appendix 3 ...............................................................................................A_5
  Pneumatic Mode - Move Select Logic Table ........................................A_5

Appendix 4 ...............................................................................................A-7
  Tolomatic Firmware Upgrade Tool .....................................................A_7
    A4.2.1 Installation Instructions ..........................................................A_9
    A4.3.1 Saving Current Drive Settings ................................................A_9
    A4.4.1 Launching the Upgrade Tool Software ....................................A_9
    A4.5.1 Upgrading Tolomatic Drive Firmware ....................................A_9
    A4.6.1 User Interface Changes - TMI/TFUT 2.2 .................................A_10
    A4.7.1 TFUT Integrated with TMI .........................................................A_12

List of Figures .......................................................................................... iv
List of Tables ........................................................................................... vii
List of Figures

Figure 3-1: User Unit Dialog Box ................................................................. 3_1
Figure 3-2: User Unit Tool Icon in menu .................................................... 3_1
Figure 4-1: Drive Tab Showing Drive Disconnected ............................... 4_1
Figure 4-2: Drive Tab Showing Drive Connected .................................... 4_2
Figure 4-3: Software Emergency Stop ....................................................... 4_3
Figure 5-1: Tolomatic Motion Interface (TMI) Tool Bar ........................ 5_2
Figure 5-2: Tool Tips Display ................................................................. 5_3
Figure 5-3: Parameter Range in Tool Tip Display ..................................... 5_3
Figure 5-4: Red Parameter Fields ............................................................ 5_4
Figure 5-5: File Menu Options ............................................................... 5_4
Figure 5-6: Tools Menu ........................................................................ 5_5
Figure 5-7: Help Menu Drop Down Options .......................................... 5_6
Figure 5-8: About Window .................................................................. 5_6
Figure 6-1: Configuration string on ERD actuator ................................. 6_1
Figure 6-2: Configuring the Tolomatic Actuator Selection .................. 6_1
Figure 6-3: Selection of Other Actuators ............................................... 6_2
Figure 6-4: New Actuator Window ......................................................... 6_2
Figure 6-5: New Actuator Window Data Entry Complete ...................... 6_3
Figure 6-6: Other Actuator Window with Multiple Model Drop Down Display .............................. 6_3
Figure 7-1: Motor Tab with Tolomatic Motor Selected .......................... 7_1
Figure 7-2: Other Motor with no Model Choices Available .................... 7_2
Figure 7-3: Edit Stepper Motor Window with Data Complete ................ 7_3
Figure 7-4: Other Motor Window with Model Added to Drop Down Display .................................................. 7_3
Figure 8-1: Mode Select Tab Window - Index default .......................... 8_1
Figure 8-2: Mode Select Tab Window - Index drop-down ...................... 8_2
Figure 8-3: Mode Select Tab Window - Analog default ......................... 8_2
Figure 8-4: Mode Select Tab Window - Analog drop-down ..................... 8_2
Figure 8-5: Mode Select Tab Window - Pneumatic ............................... 8_2
Figure 8-5: Mode Select Tab Window -Ethernet/IP .............................. 8_2
Figure 8-6: Mode Select Tab Window -Modbus TCP ............................ 8_3
Figure 8-8: Mode Select Tab Window - Modbus RTU ............................ 8_3
Figure 9-1: Default Configuration and Options for 4 Move Command .... 9_2
Figure 9-2: Default Configuration and Options for 8 Move Command .... 9_3
Figure 9-3: Default configuration and Options for 16 Move Command .... 9_3
Figure 9-4: Default configuration and Options for Analog Position mode . 9_4
Figure 9-5: Default configuration and Options for Network mode ......... 9_4
LIST OF FIGURES

Figure 10-1: Fault Tab Default Configuration .................................................. 10_1
Figure 10-2: Fault Tab with Positive & Negative Limit Switches Enabled........... 10_2
Figure 11-1: Safety/Limits Tab ....................................................................... 11_1
Figure 11-2: Zone Bounds Diagram ............................................................... 11_3
Figure 12-1: Home Setup Tab ........................................................................ 12_1
Figure 13-1: Mode Setup- 4 Move Commands, Not Configured ....................... 13_2
Figure 13-2: Mode Setup- 8 Move Commands, Not Configured ....................... 13_2
Figure 13-3: Mode Setup- 16 Move Commands, Not Configured ................. 13_3
Figure 13-4: Mode Setup- The Home & No Action commands disable several fields. ................................................................. 13_3
Figure 13-5: Software Controlled User Options ............................................... 13_5
Figure 13-6: Digital Input Controlled .............................................................. 13_6
Figure 13-7: Configured Mode Setup, 16 Move Command Mode ................... 13_6
Figure 13-8: Pneumatic, Spring ..................................................................... 13_7
Figure 13-9: 2 Position (2 input) ................................................................. 13_8
Figure 13-10: 3 Position (2 input) ............................................................... 13_8
Figure 13-11: 3 Position (3 input) ............................................................... 13_8
Figure 13-12: Digital Input Controlled ............................................................ 13_9
Figure 13-13: Default Analog Position Mode for Voltage.............................. 13_10
Figure 13-14: Settings for Analog Position mode for Voltage ....................... 13_10
Figure 13-15: Simulating Analog Input .......................................................... 13_10
Figure 13-16: Confirm motion warning window ............................................ 13_10
Figure 13-17: Analog Input Controlled .......................................................... 13_10
Figure 13-18: Sample of completed Analog I/O calibration ......................... 13_10
Figure 13-19: Modbus RTU Controlled ......................................................... 13_10
Figure 13-20: EtherNet/IP Controlled ............................................................ 13_10
Figure 13-21: Modbus TCP Controlled ........................................................ 13_10
Figure 13-22: Software in control, last commanded move is highlighted ....... 13_10
Figure 13-23: Drive Status tool indicates Software (Host) is in control ........... 13_10
Figure 13-24 EtherNet/IP (or Modbus TCP, Modbus RTU) in control, last commanded move is highlighted ................................................... 13_10
Figure 13-25: Drive Status tool indicates EtherNet/IP (or Modbus TCP, Modbus RTU) is in control ................................................... 13_10
Figure 14-1: Launching the Motion Manager Tool ........................................... 14_1
Figure 14-2: Motion Manager Panel .............................................................. 14_2
Figure 15-1: Launching the Digital I/O Tool ..................................................... 15_1
LIST OF FIGURES

Figure 15-2: Digital I/O Tool................................................................. 15_1
Figure 16-1: Launching the Analog I/O Tool................................. 16_1
Figure 16-2: Analog I/O Tool ............................................................... 16_1
Figure 17-1: Launching the Drive Status Tool ............................. 17_1
Figure 17-2: Drive Status Tool .............................................................. 17_1
Figure 18-1: Ready to manually enter the IP address............. 18_1
Figure 18-2: A manually entered IP address, ready to test ........ 18_1
Figure 18-3: Testing verifies a successful Network connection ...... 18_2
Figure 18-4: Testing indicates a failed attempt for Network connection... 18_2
Figure 18-5: Click OK when Network configuration is complete .... 18_3
Figure 19-1: Advanced Diagnostics pull-down ......................... 19_1
Figure 19-2: Ethernet MIB (Management Information Base) Counters ... 19_1
Figure A1-1 Input Requirement .......................................................... A_1
Figure A1-2 System Startup Timing ............................................... A_1
Figure A1-3 Jog Move Timing ......................................................... A_1
Figure A1-4 Start Motion Timing ...................................................... A_2
Figure A1-5 Pneumatic Timing .......................................................... A_2
Figure A4-1: Select the correct version of the Firmware Upgrade Tool ... A_9
Figure A4-2: Initial Upgrade Tool Window ......................................... A_9
Figure A4-3: Displaying Version and Restoring to Factory Setting ... A_9
Figure A4-4: Programming Complete .................................................. A_9
Figure A4-5 Updated interface ......................................................... A_10
Figure A4-6 Connected to ACS Drive ................................................ A_10
Figure A4-7: Firmware Flashing Progress ........................................ A_11
Figure A4-8: Firmware Flashing Complete ....................................... A_11
Figure A4-9: Upgrade Firmware now available within TMI ........... A_12
List of Tables

Table 1-1: Hardware Requirements ................................................................. 1
Table 5-1: TMI Setup Wizard Navigation Tabs ................................................... 5
Table 5-2: File Menu Drop Down Descriptions ................................................ 5
Table 5-3: Tools Menu Drop Down Descriptions .............................................. 5
Table 9-1: Descriptions of Digital Input Functionality ...................................... 9
Table 9-2: Descriptions of Digital Output Commands ...................................... 9
Table 10-1: Safety Faults Descriptions ......................................................... 10
Table 10-2: Critical Faults Descriptions ......................................................... 10
Table 13-1: Descriptions of Setup Table Move Definitions for 4, 8, and 16 Move
Commands ........................................................................................................ 13
Table 13-2: Descriptions of Setup Table Move Definitions for Pneumatic Mode
......................................................................................................................... 13
Table 19-1: ACS Ethernet Drive MIB counters .............................................. 19
Table A2-1: 4 Move Commands Mode Logic ................................................. A
Table A2-2: 8 Move Commands Mode Logic .................................................. A
Table A2-3: 16 Move Commands Mode Logic ................................................. A
Table A2-4: 4 Move Commands Mode Logic .................................................. A
Table A2-5: 8 Move Commands Mode Logic .................................................. A
Table A2-6: 16 Move Commands Mode Logic ................................................ A
Table A3-1: 2 Position (1 input) Mode Logic ................................................. A
Table A3-2: 2 Position (2 input) Mode Logic ................................................. A
Table A3-3: 3 Position (2 input) Mode Logic ................................................. A
Table A3-4: 3 Position (3 input) Mode Logic ................................................ A
1.1 Host Computer and Software System Requirements

The Tolomatic Motion Interface (TMI) is designed to work with a host PC with Windows® operating systems. Before installing the TMI software, be sure the host PC has the minimal host requirements indicated below.

### 1.1.1 Hardware Requirements

<table>
<thead>
<tr>
<th>HARDWARE</th>
<th>MINIMUM REQUIREMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz</td>
</tr>
<tr>
<td>RAM</td>
<td>512 MB</td>
</tr>
<tr>
<td>Disk Space 32-Bit</td>
<td>600 MB</td>
</tr>
<tr>
<td>Disk Space 64-Bit</td>
<td>1.5 GB</td>
</tr>
<tr>
<td>USB</td>
<td>1 USB Connection</td>
</tr>
<tr>
<td>USB to Serial Converter</td>
<td>1 USB to Serial Converter</td>
</tr>
</tbody>
</table>

*Table 1-1: Hardware Requirements*

### 1.1.2 Operating Systems Supported

The Tolomatic Motion Interface (TMI) is compatible with the following operating systems: Windows® 7 and Windows® XP.

For all platforms, it is recommended that you upgrade to the latest Windows Service Pack and critical updates from the Windows Update Web Site at [http://go.microsoft.com/fwlink/?Linkid=168461](http://go.microsoft.com/fwlink/?Linkid=168461) to ensure the best compatibility and security.

The TMI software is not supported on IA-64-based (Itanium) systems.
2.1 Installation Instructions

2.1.1 Installing from the Tolomatic CD

1. Insert the software CD supplied by Tolomatic into the CD-ROM drive in your PC.
2. Follow the link on the displayed web page to install the latest software and view the manuals (requires internet connection)
3. If internet connection is not available, browse the CD and double-click the "TolomaticMotionInterface[version].exe" file to run the installer.
4. Follow the prompts to install the software.

The software will install a program launch icon in the Windows® Start menu at:
Start > All Programs > Tolomatic > TolomaticMotionInterface[version] > TolomaticFirmwareUpgradeTool
In the Start menu the program will start with a single click.

2.1.2 Downloading and Installing from the Tolomatic Web Site at www.tolomatic.com

The Tolomatic Motion Interface can be downloaded from the Tolomatic web site at www.tolomatic.com

1. To download, click on "Product Resources" in the navigation bar at top. Select "Electric Linear Motion" from the "Choose a Product Line:" drop-down list and select “Software” from the "Choose a Resource Type:" drop-down listing.
2. Select the TMI software from the resulting list and when prompted save the file to the programs folder on your hard drive.
3. Double-click the "setup.exe" file to run the installer.
4. Follow the prompts to install the software.

The software will install a program launch icon in the Windows® Start menu at:
Start > All Programs > Tolomatic > TolomaticMotionInterface[version] > TolomaticFirmwareUpgradeTool
In the Start menu the program will start with a single click.
3.1 Launching the TMI Software

1. To launch the software in the Windows® Start menu navigate to: Start > All Programs > Tolomatic > TolomaticMotionInterface.

2. When the TMI is launched for the first time, the software will automatically display the User Units dialog box (shown below, Figure 3-1) which defines the units displayed in the software. The user has two selections for linear actuator units: inches (US Linear) or mm (SI Linear).

3. The user must select the desired units and click Apply. Once the apply button is clicked TMI will no longer automatically display the User Units dialog box on application launch. To access the User Units dialog box click on the ruler icon in the tool bar at top. The units can be changed at any time and all displayed parameters in the software will be adjusted accordingly.
4.1 Establishing Communication with the Tolomatic ACS Drive

RS-232 is the current communication protocol used to configure the Tolomatic ACS Drive/Controller. EtherNet/IP is also available.

Currently there are three ACS Drive/Controller choices:

- #3604-9651 - ACS Stepper Drive/Controller, Modbus RTU (Analog Output)
  - firmware 36043144SD.hex
- #3604-9654 - ACS Stepper Drive/Controller, EtherNet/IP (Analog Output)
  - firmware 36043175ED.hex
- #3604-9655 - ACS Stepper Drive/Controller, Modbus TCP (Analog Output)
  - firmware 36043176MD.hex

NOTE: They will collectively be referred to as ACS Drive throughout this guide.

1. After the User Units have been selected on initial startup, and from then on once the TMI is launched, the software will automatically default to the Drive tab shown in Figure 4-1 below.

![Figure 4-1: Drive Tab Showing ACS Drive Disconnected](image)

2. Using the 'Auto' selection for Port, the TMI can cycle through all available COM ports to attempt to connect to the Tolomatic ACS Drive. (If no ACS Drive is found, the status bar (at bottom) will display "Disconnected" and the text box will display "Unable to connect to any RS-232 port" message.) The user...
can also select a specific port from the list of available COM ports. Once successful communication is established, the TMI will remember that port for subsequent sessions. The Baud rate is set to 38400 and can not be changed.

3. Upon establishing communication with the ACS Drive, the TMI software automatically reads all the current settings in the ACS Drive and updates the software interface accordingly. As shown in Figure 4-2, the ACS Drive information is displayed in several fields: Name of ACS Drive given by user; ACS Drive information including Model and Firmware Version; and a Photo of the Tolomatic ACS Drive product being configured (ACS Stepper Drive/Controller is pictured). If the ACS Drive has Network hardware, the MAC address will also be displayed.

![Figure 4-2: Drive Tab Showing ACS Drive Connected](image)

4. The TMI software also opens a Software Stop window shown in Figure 4-3. This Software Stop window is intended to be a software emergency stop. If the user clicks on the stop button, the actuator will immediately stop. The Tolomatic ACS Drive will be disabled along with the output to the motor. If the motor does not have an encoder homing will be required to re-establish absolute position reference. For safety reasons this window is intended to always be on top of other windows.
4.2 Offline Connection

The TMI software also supports an offline connection that allows the user to create, edit and save drive configuration files without the Tolomatic ACS Drive being present. This is a useful development and debug tool to create and analyze the drive configuration files.

With the Offline connection, all controls related to motion or enabling/disabling drive are disabled. The offline connection does not allow the user to simulate motion or debug logic.
5.1 Navigating through the Tolomatic Motion Interface (TMI)

### 5.1.1 Setup Wizard Tabs

The TMI software for configuring the ACS Drive is designed as a setup wizard. It uses tabs, navigating from left to right through all the steps needed to configure the ACS Drive and create motion. As shown below, there are multiple tabs which are used in the setup process.

**TMI Setup Wizard Navigation Tabs**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive</td>
<td>Establish communication and verify ACS Drive identification information such as model and firmware version.</td>
</tr>
<tr>
<td>Actuator</td>
<td>Configure a Tolomatic actuator or create a custom actuator in the “Other Actuator Catalog.”</td>
</tr>
<tr>
<td>Motor</td>
<td>Configure or view parameters of a Tolomatic motor or create a 3rd party motor file in the “Other Motor Catalog.”</td>
</tr>
<tr>
<td>Mode</td>
<td>Select the desired operating mode. Tolomatic ACS Drive products were designed to have dedicated operating modes to simplify the configuration and operation of the ACS Drive. Currently, there are four operating modes, depending on model: Index Move, Pneumatic, Analog Position and Network (EtherNet/IP, ModbusTCP, Modbus RTU)</td>
</tr>
<tr>
<td>I/O</td>
<td>Configure the functionality of the digital inputs and digital outputs of the ACS Drive. The TMI will automatically configure a suggested I/O map based on the selected operating mode.</td>
</tr>
<tr>
<td>Fault</td>
<td>Enable/disable faults, and configure the action taken for the displayed faults.</td>
</tr>
<tr>
<td>Safety/Limits</td>
<td>Configure safety parameters and motion limits such as: in position, position error, maximum velocity/accel/decel, current limit, software limits and zone bounds</td>
</tr>
<tr>
<td>Home Setup</td>
<td>Configure the homing routine parameters such as type, direction, velocity, force, and home on power-up.</td>
</tr>
<tr>
<td>Mode Setup</td>
<td>Setup the operating Mode selected in the Mode Setup tab. For example, in Index Move mode, the user configures move type, position, velocity, acceleration, deceleration and force for all the moves.</td>
</tr>
</tbody>
</table>

*Table 5-1: TMI Setup Wizard Navigation Tabs*

#### 5.1.2 Tolomatic Logo

The TMI software uses the Tolomatic Logo (shown above) to guide the user through the software in order to correctly configure all necessary parameters. Notice in Figure 4-2 & 5-1 showing that the ACS Drive is connected, the Tolomatic logo has moved to the Actuator tab which is the next required step—configuring the actuator. The Drive tab remains highlighted in Blue which gives the user visual indication of the currently selected tab.
5.1.3 Tool Bar

![Tolomatic Motion Interface (TMI) Tool Bar](image)

The Tool Bar includes the following:

- **Drive Connect**: Connect or disconnect communication to the ACS Drive.

- **Network Setup (optional)**: Set up ACS Drive for Network communication.

- **Open**: Open a previously saved drive configuration file to setup all the parameters of the ACS Drive.

- **Save**: Save all parameters to a drive configuration file for later use.

- **Restore Current Settings from Drive Flash**: Read all parameters from drive flash memory into the TMI software.

- **Write Current Settings to Drive Flash**: Write all parameters from the TMI software into the drive flash memory.

- **Software Stop**: Disables ACS Drive and output to the motor

- **Home**: Initiates a home routine

- **Motion Manager tool**: Tool used to create simple moves such as absolute, incremental and jog. All motion profile parameters are adjustable through this tool.
Tuning Filter tool: Tool not implemented at time of this release.

Drive Status tool: Tool used to notify user of critical drive information such as Enable status, Home status, In Position status and Faults (see Section 17: Drive Status Tool).

Digital I/O tool: Tool used to view the status of the Digital Inputs and Digital Outputs (see Section 15: Digital I/O Tool).

Analog I/O tool: Tool used to view the status of the Analog Inputs and Analog Outputs (see Section 16 Analog I/O Tool).

Fault History tool: Tool not implemented at time of this release.

User Units tool: Tool to select application user units. At time of this release, units are selected in inches or millimeters.

5.1.4 Tool Tips

As the user moves the mouse over Tool Bar items, drive parameters or action buttons, the TMI will display a tool tip providing useful information about that item.

Tool Tip Displays: Moving the mouse over a parameter field will activate the Tool Tips display and it will show the allowable range for that parameter. If a user attempts to enter a lower number than is allowed, the TMI software will automatically default to the minimum allowable value. If a user attempts to enter a higher number than is allowed, the TMI will automatically default to the maximum allowable value.
### 5.1.5 Parameter Entry

**Red Parameter Field:** The TMI will automatically shade any parameter field a red color if that parameter has not been configured (see Figure 5-4). This is a notice to the user that this parameter must be configured before continuing or creating motion.

![Figure 5-4: Red Parameter Fields](image)

### 5.1.6 File Menu

#### File Menu Drop Down Descriptions

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open a drive configuration file to setup all the parameters of the ACS Drive.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves all parameters to a drive configuration file. If user hasn’t given a name to the file yet, a File Save window will be opened.</td>
</tr>
<tr>
<td>Save As</td>
<td>Opens a File Save window to allow user to select location and name of drive configuration file.</td>
</tr>
<tr>
<td>Write Current Settings to Drive Flash</td>
<td>Write all parameters from the TMI software into the drive flash memory.</td>
</tr>
<tr>
<td>Read Current Settings from Drive Flash</td>
<td>Read all parameters from drive flash memory into the drive’s RAM and into the TMI software.</td>
</tr>
<tr>
<td>Restore ACS Drive to Factory Settings</td>
<td>Restores all parameters in the ACS Drive flash and RAM memory to factory defaults.</td>
</tr>
<tr>
<td>Read Current Settings from ACS Drive</td>
<td>Reads all parameters in ACS Drive RAM into the TMI software (Performed automatically when communication is established)</td>
</tr>
</tbody>
</table>

Table 5-2: File Menu Drop Down Descriptions

**NOTE:** Executing any Open, Restore or Read operation will result in the TMI software automatically navigating to the Drive Tab and updating all parameters in TMI to the current drive settings.
5.1.7 Tools Menu

![Figure 5-6: Tools Menu](image)

<table>
<thead>
<tr>
<th>Tools Menu Drop Down Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Motion Manager</strong></td>
</tr>
<tr>
<td><strong>Tuning Filter</strong></td>
</tr>
<tr>
<td><strong>Drive Status</strong></td>
</tr>
<tr>
<td><strong>Digital I/O</strong></td>
</tr>
<tr>
<td><strong>Analog I/O</strong></td>
</tr>
<tr>
<td><strong>Fault History</strong></td>
</tr>
<tr>
<td><strong>User Units</strong></td>
</tr>
<tr>
<td><strong>Software Stop</strong></td>
</tr>
<tr>
<td><strong>Network Setup (optional)</strong></td>
</tr>
</tbody>
</table>

*Table 5-3: Tools Menu Drop Down Descriptions*
5.1.8 Help Menu

![Help Menu Drop Down Options](image)

**ACS Hardware & Installation Guide:** Launches a PDF of the manual with ACS Drive specifications, wiring diagrams, connector and cable information.

**Tolomatic Motion Interface (TMI) Software Guide:** Launches a PDF of this manual.

**About:** Indicates the current software version of the Tolomatic Motion Interface and the build date.

![About Window](image)
6.1 Using the Actuator Tab

The Actuator tab is used to configure a Tolomatic actuator or create a different actuator in the Other Actuator Catalog. The default selection of the radio button is Tolomatic Actuator.

### 6.1.1 Tolomatic Actuator Selection

1. Identify the actuator configuration string on the actuator. Enter Model, Size, Screw/Nut Lead, Stroke Units (either SM for mm, or SK for inches), length of Stroke in units specified, Motor Mount, and Motor option.

![Figure 6-1: Configuration string on ERD actuator](image)

2. When Model is configured, a photo of the actuator will be shown. (Note: ALL Tolomatic electric actuators can be selected from the model drop down menu.)

![Figure 6-2: Configuring the Tolomatic Actuator Selection](image)

**NOTE:** When you have completed filling in the configuration string the Tolomatic logo will move to the next tab requiring attention.

### 6.1.2 Other Actuator Selection

The Other Actuator Catalog allows a user to keep any number of Other Actuator models in the file for convenience and later reference.
1. If no Other Actuators have been created there will be no selections under the Models drop down. In this case, the user must click the New button at the bottom of the screen (see Figure 6-3).

![Figure 6-3: Selection of Other Actuators](image)

2. Clicking the New button, will bring up a New Actuator dialog in which the user must enter critical information about the actuator (see figure 6-4)

3. Model field: Enter the name selected for the Other Actuator. It will remain red until the user enters a unique name that has not already been saved into the Other Actuator Catalog.

4. Description field: Enter a unique description of the Other Actuator, up to a 28 alpha-numeric character entry that is all uppercase. This field is optional.

5. Stroke field: Enter the stroke in the selected user units. There is no stroke limit for Other Actuators.

![Figure 6-4: New Actuator Window](image)
4. Linear Units Ratio field: These numerator and denominator entries are used to setup the ratio of rotary motor revolutions to linear distance in selected user units per motor revolution. If there is a gearbox inline with the motor, this ratio must be taken into account and entered accordingly.

For example, if there is an Other Actuator with an 0.5" lead screw, then the Linear Units Ratio would look as in Figure 6-5 below. All the required fields have been entered properly and the parameters have been validated. This activates the Save button.

![Figure 6-5: New Actuator Window Data Entry Complete](image)

5. Clicking the save button adds the New Actuator information to the Other Actuator catalog. The name of the new actuator is automatically added to the Model drop down for later reference.

![Figure 6-6: Other Actuator Window with Multiple Model Drop Down Display](image)
7.1 Using the Motor Tab

The Motor tab is used to configure a Tolomatic motor or create a different motor in the Other Motor Catalog. The default selection of the radio button is Tolomatic Motor.

### 7.1.1 Tolomatic Motor Selection

1. Verify the correct Motor selection and settings are displayed.
2. All parameters except the Reverse Direction check box are automatically populated with those of the selected motor and are disabled from entry.
   
   If the user wishes to select a different motor Model that is acceptable for the actuator chosen, then simply select a new motor from the Model drop down.
3. Depending on the actuator configuration or the actuator installation in the machine, the user may wish to reverse the direction of the motor’s positive direction. Default positive motion direction is CW (clockwise). To change it to CCW (counter-clockwise), the Reverse Direction check box must be checked.

![Figure 7-1: Motor Tab with Tolomatic Motor Selected](image)

### 7.1.2 Other Motor Selection

The Other Motor catalog allows a user to keep any number of motor models compatible with the ACS Drive in the file for convenience and later use. At the time
of this release, stepper motors are the only available option. Selection of a motor other than one supplied by Tolomatic is done in a similar procedure as selecting an Other Actuator.

1. If no Other Motors have been created there will be no selections under the Models drop down (see Figure 7-2). In this case, the user must click the New button at the bottom of the screen.

![Figure 7-2: Other Motor with no Model Choices Available](image)

2. Clicking the New button, will bring up a New Stepper Motor dialog box in which the user must enter the motor name, description (28 alpha-numeric characters in uppercase), and specifications. Once the information entered has been validated, the light red fields will disappear and the save button will become active.

3. Clicking the save button adds the New Motor information to the Other Motor catalog. The name of the new motor is automatically added to the Model drop down for later reference.

4. Depending on the actuator configuration or the actuator installation in the machine, the user may wish to reverse the direction of the motor’s positive direction. Default positive motion direction is CW (clockwise). To change it to CCW (counter-clockwise), the Reverse Direction check box must be checked.
Figure 7-3: Edit Stepper Motor Window with Data Complete

Figure 7-4: Other Motor Window with Model Added to Drop Down Display
8.1 Using the Mode Select Tab

At time of this release, the software supports four different operating modes: Index Move, Analog Position, Pneumatic and Network. Network mode supports one of the following protocols: Modbus RTU, EtherNet/IP or Modbus TCP.

The Index Move mode supports 4, 8, and 16 move commands. These move commands can be configured to be Absolute, Incremental, Jog, Home or No Action moves. The motion profile can be independently set for each move. The motion profile includes velocity, acceleration, deceleration and force which is setup in the Mode Setup tab (see Section 13: Mode Setup Tab).

The Analog Position mode supports both voltage (0 to 10 Vdc) and current (0 to 20 mA) on the analog input and analog output. The ACS Drive follows the analog input based on a scaled position range while the analog output value is based on the scaled encoder position.

The Pneumatic mode is used to replace or mimic pneumatic cylinder/valve operation logic. With pneumatic mode there are four different selections: Spring, 2 Position (2 input), 3 Position (2 input) & 3 Position (3 input). These four pneumatic mode operations allow just about any pneumatic valve logic to be replaced with the ACS drive. Additionally, in pneumatic mode, the drive will automatically home the actuator upon power up based on the home setup configuration.

The Network mode supports one of the Modbus RTU, EtherNet/IP or Modbus TCP protocols. The ACS Drive can then accept commands to change motion profile, command infinite positions, monitor status and provide diagnostics.

NOTE: The ACS drive models and modes are as follows:

<table>
<thead>
<tr>
<th>ACS Model</th>
<th>Number</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST0324SD</td>
<td>3604-9651</td>
<td>Index Move, Analog Position, Pneumatic Modbus RTU</td>
</tr>
<tr>
<td>ST0324ED</td>
<td>3604-9654</td>
<td>Index Move, Analog Position, EtherNet/IP</td>
</tr>
<tr>
<td>ST0324MD</td>
<td>3604-9655</td>
<td>Index Move, Analog Position, Pneumatic Modbus TCP</td>
</tr>
</tbody>
</table>

Figure 8-1: Mode Select Tab Window - Index default
NOTE: The TMI software will determine if ModBus RTU, EtherNet/IP or Modbus TCP is appropriate based on the connected ACS Drive and firmware version.

Figure 8-2: Mode Select Tab Window - Index drop-down

Figure 8-3: Mode Select Tab Window - Analog default

Figure 8-4: Mode Select Tab Window - Analog drop-down

Figure 8-5: Mode Select Tab Window - Pneumatic drop-down
NOTE: The TMI software will determine if ModBus RTU, EtherNet/IP or Modbus TCP is appropriate based on the connected ACS Drive and firmware version.

Figure 8-8: Mode Select Tab Window - Modbus RTU

Figure 8-6: Mode Select Tab Window - EtherNet/IP

Figure 8-7: Mode Select Tab Window - Modbus TCP
9.1 Using the I/O Tab

The digital input and digital output functionality are configured using the I/O tab. Default I/O configurations are set up for the selected mode and are shown after the Digital Input and Output Command Tables in Figures 9-1 through 9-4.

### 9.1.1 Digital Inputs

<table>
<thead>
<tr>
<th>Digital Input Functionality</th>
</tr>
</thead>
</table>
| **Enable** | Enables or Disables the ACS Drive and power to the motor.  
NOTE: Faults configured to Disable Motor (see Section 10: Fault Tab) will require PLC or logic device to cycle level of Enable input to re-enable the ACS Drive. Cycling this input when there is no feedback device will clear the Home output. |
| **Start Motion** | Initiates the selected move command from the Move Select inputs. |
| **Stop Motion** | Stops move in progress with controlled deceleration. |
| **Home** | Initiates the homing routine setup in the Home Setup tab (see Section 12: Home Setup Tab). |
| **E-stop** | Executes a software stop which either stops motion or disables ACS Drive depending on the fault configuration in the Fault tab (see Section 10: Fault Tab). |
| **Move Select 1-4 Inputs** | Selects move for execution based on Index Move mode (see Appendix 2 for Move Select Logic) or Pneumatic mode (see Appendix 3 for Move Select Logic) |
| **Positive Limit Switch** | Stops motion or disables the ACS Drive depending on the fault configuration in the Fault tab (see Section 10: Fault Tab). |
| **Negative Limit Switch** | Stops motion or disables the ACS Drive depending on the fault configuration in the Fault tab (see Section 10: Fault Tab). |

**Table 9-1: Descriptions of Digital Input Functionality**


### 9.1.2 Digital Outputs

<table>
<thead>
<tr>
<th>Digital Output Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Motion Complete</strong></td>
</tr>
</tbody>
</table>
| **Home Complete** | Signal to PLC or logic device indicating whether ACS Drive/motor combination is homed (on) or not homed (off).  
NOTE: When homing is in progress, the Home Complete output will be off. |
Digital Output Functionality

<table>
<thead>
<tr>
<th>Fault</th>
<th>Signal to PLC or logic device indicating that a fault has occurred. The steps to reset the fault are different depending on the fault category (see section 10: Fault Tab) for a complete description of faults and recovery.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone (Optional)</td>
<td>Signal to PLC or logic device indicating that the position of the actuator is within the Zone Positive Bound and Zone Negative Bound setup in the Safety/Limits tab (see Section 11: Safety/Limits Tab).</td>
</tr>
</tbody>
</table>

Table 9-2: Descriptions of Digital Output Commands


9.1.3 Default Configurations for Operating Modes

![Figure 9-1: Default Configuration and Options for 4 Index Move Command](image-url)
Figure 9-2: Default Configuration and Options for 8 Index Move Command

Figure 9-3: Default configuration and Options for 16 Index Move Command
Figure 9-4: Default configuration and Options for Analog Position mode

Figure 9-5: Default configuration and Options for Pneumatic mode
Figure 9-6: Default configuration and Options for Network modes (one of these protocols: Modbus RTU, EtherNet/IP or Modbus TCP)
10.1 Using the Fault Tab

The Fault tab allows the user to configure the response of the Safety Faults. The Critical Faults are always enabled and the configured response is to disable the motor. Critical Faults are listed for information only.

The default configuration for the faults is with the Positive/Negative Limit Switch disabled and Position Error / E-Stop enabled as shown below. However, if digital inputs have been mapped as Positive/Negative limit switches these fault will be enabled and checked by default. The default response for any Safety Fault is to Stop Motion, although an alternative response can be configured through the drop down to Disable Motor. To enable the Positive/Negative Limit Switch faults go to the I/O tab (see Section 9: I/O Tab).

Figure 10-1: Fault Tab Default Configuration
10.2 Fault Descriptions and Recovery

Faults are divided into Safety Faults and Critical Faults.

Safety Faults are configurable. If the fault is configured as a stop motion, the fault will be cleared automatically once the fault condition is no longer present. If a safety fault is enabled and configured for disable motor, the fault will be latched until it is cleared in the same manner as the critical faults described at left.

All Critical Faults will disable the motor when they occur. To clear these faults, the fault condition cannot be present and the enable input line must be lowered and then raised to proceed with motion.

<table>
<thead>
<tr>
<th>Safety Faults Table</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Positive Limit Switch</strong></td>
</tr>
<tr>
<td><strong>Negative Limit Switch</strong></td>
</tr>
</tbody>
</table>

NOTE: To clear faults that disable the motor; PLC needs to lower/raise the enable digital input, toggle the enable bit using Network or TMI user must press the Enable button on the motion manager.
The Fault Tab

NOTE: To clear faults; PLC needs to lower/raise the enable digital input, enable bit using EtherNet/IP or TMI user must press the Enable button on the motion manager.

### Safety Faults Table

<table>
<thead>
<tr>
<th>Fault</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Error</td>
<td>If an encoder is present, the position error fault can be enabled. If encoder position and commanded position differ by a larger magnitude than the defined position error, the position error fault will be activated. If fault is configured as a stop motion, fault will be cleared on next move command. NOTE: If force is less than 100%, a position error fault will not be triggered. It will stop and hold position (push mode).</td>
</tr>
<tr>
<td>E-Stop</td>
<td>If an input is configured as an E-stop and fault is enabled, this fault will be activated when the signal level on the pin is high. This fault is configured as a stop motion, it will be cleared once the E-stop input is lowered. Motion will not be allowed until E-stop has been cleared.</td>
</tr>
</tbody>
</table>

### Critical Faults Table

<table>
<thead>
<tr>
<th>Fault</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feedback Error</td>
<td>Feedback device is malfunctioning.</td>
</tr>
<tr>
<td>Over Current</td>
<td>If a short circuit occurs from output to ground, this fault will be triggered.</td>
</tr>
<tr>
<td>Motor Over Temp</td>
<td>Not implemented in this release.</td>
</tr>
<tr>
<td>Drive Over Temp</td>
<td>Drive temperature is greater than the maximum allowed temperature (75°C).</td>
</tr>
<tr>
<td>Drive Over Voltage</td>
<td>Main power voltage exceeds the maximum voltage.</td>
</tr>
<tr>
<td>Drive Under Voltage</td>
<td>Main power voltage below the minimum voltage.</td>
</tr>
</tbody>
</table>

Table 10-1: Safety Faults Descriptions

Table 10-2: Critical Faults Descriptions
11.1 Using the Safety/Limits Tab

The Safety/Limits tab is used to configure Safety parameters, Motion Limits and setup such features as Endpoint Correction or Zone Output.

![Figure 11-1: Safety/Limits Tab]

11.1.1 In Position Criteria

**In Position**: This value defines the +/- window around the desired target position that is considered within position.

**Endpoint Correction**: When enabled, Endpoint Correction initiates one correcting move at the end of the initial move to correct any position error that is greater than the In Position value. At the end of the initial move, the distance of the corrected move will be the difference between Target Position & Actual Position. This correcting move will use the same motion profile parameters (velocity, accel, decel, force) as the initial move. Endpoint Correction is only available with stepper motors with encoders.

11.1.2 Position Error

This value defines the +/- window around the commanded position that the actual position must be within or a Position Error fault will occur.

Position Error = Commanded Position – Actual Position.
The Position Error is calculated throughout the entire move. Position Error is only available with motors with encoders. A Position Error can only be generated if the Force % setting equals 100%. When the Force % is set to less than 100%, the actuator will be in “push” mode where a following error will stop and hold current position with no Position Error being generated. The Position Error setting must always be larger than the setting for the In Position parameter. If the Position Error setting is smaller than the In Position setting, the In Position parameter will turn red, indicating an invalid setting.

### 11.1.3 Motion Limits

**Maximum Velocity:** This value defines the maximum velocity that is allowed to be configured by the software and commanded by the ACS Drive. The TMI software will automatically cap any entered velocity value to the max setting. When the actuator & motor information is entered, the TMI software will automatically calculate the Maximum Velocity setting using the actuator max speed and motor max RPM. The ACS Drive ensures that no moves can be commanded with a velocity value higher than the max setting.

**Maximum Accel/Decel:** This value defines the maximum accelerations and decelerations that are allowed to be configured by the software and commanded by the ACS Drive. The TMI software will automatically cap any entered value to the maximum Accel/Decel setting. When the actuator and motor information are entered, the TMI software will automatically set the Maximum Accel/Decel parameter to 30 times the maximum allowable velocity setting. The maximum allowable Accel/Decel is 40 times the maximum allowable velocity. The ACS Drive ensures that no moves can be commanded with an acceleration or deceleration value higher than the value of the Maximum Accel/Decel parameter.

*Note:* If zero (0) velocity or accel/decel is entered, these parameters will turn red and the Tolomatic logo will appear on the Safety/Limits tab.

### 11.1.4 Current Limits

**Over current:** At the time of this release, this value is hard coded to 4 Amps for the ACS drive due to its internal circuit design. If a short circuit occurs, this will trigger an Over Current Fault.

**Current Limit:** This value defines the current applied to the stepper motor for all moves unless a Force % is set to less than 100% for any Move Command in the Mode Setup tab. The current limit value is automatically set by the motor selection from the Motor Tab. The value cannot be set higher than the motor value but its value can be reduced.

**Holding Current:** This value defines the current level (in percentage) to which the ACS Drive sets the output current to the motor when any move is complete. The ACS Drive maintains this current level to the motor until the next Move Command is executed. The default value for this parameter is 100%. This parameter can be used to conserve energy while the motor is at rest.
11.1.5 Positive/Negative Limits

**Software Limits:** There are two software limits, a *positive* and a *negative*. These software limits create a virtual position boundary for the motor/actuator system which the ACS Drive can not be commanded to exceed. The exception to this rule is for homing. A home command will ignore both software limits and will ignore limit switches if move to hard stop is selected. The TMI software will automatically cap any move to the positive software limit if the entered value is larger, or to the negative software limit if the entered value is smaller. The default values of the software limits are dependent upon the following homing sequences:

1. **Home to Hardstop**
   - Negative home direction: Positive Software Limit = Stroke – Home Offset; Negative Software Limit = - Home Offset
   - Positive home direction: Positive Software Limit = + Home Offset; Negative Software Limit = - Stroke + Home Offset

2. **Home to Limit Switch**
   - Negative Software Limit = - Stroke; Positive Software Limit = + Stroke

   **Note:** The software limits must be changed to restrict motion bounds.

**Zone Bounds:** This feature is only visible if the Zone output is enabled on the I/O tab (see Section 9: I/O Tab). There are two zone bounds, a *positive* and a *negative*. These zone bounds define a virtual position window that is monitored at all times by the ACS Drive. When the actual position is greater than or equal to the Negative Bound Zone and less than the Positive Bound Zone, the Zone Output will be on. The TMI software has rules regarding these zones. The Zone Positive Bound is always smaller than the Positive Software Limit but larger than the Negative Software Limit. The Zone Negative Bound is always larger than the Negative Software Limit but smaller than the Positive Software Limit. The Zone Output feature does not interfere with motion. This feature can be used in a variety of applications to prevent a collision with another axis of motion or to initiate a process during a specific position range.

![Zone Bounds Diagram](image-url)
12.1 Using the Home Setup Tab

The Home Setup tab is used to configure the homing routine. Every home routine has a configurable motion profile (velocity, accel/decel, force), a choice of direction, and an option to home on power-up.

![Image: Home Setup Tab](image)

**Figure 12-1: Home Setup Tab**

Status Bar Indicators have been added to the status bar to indicate when a Fault condition exists (red light on the ACS drive flashing) or when the current actuator position is within the In Position criteria of the currently programmed software limit.

- Double-clicking on the Yellow indicator will navigate to the Safety/Limits tab so you can review the currently programmed Software Limits and In Position Criteria.
- Double-clicking on the Red indicator will display the Drive Status window.

### 12.1.1 Method of Homing

There are two different types of homing routines:

**Homing To Hard Stop**

1. **With encoder**: This home routine uses the encoder to detect position error to find the hard stop during home.

2. **Without encoder**: This home routine initiates an incremental move the size of one stroke length. This ensures that the actuator will find the hard stop since there is no encoder to help detect it. Warning: Depending on where the actuator is positioned when homing begins, this routine may cause the motor/actuator to push against the hard stop for several seconds. This is not ideal for the mechanical system and may cause audible noise.
NOTE: To ensure repeatability it is best to home with relatively slow velocity (<=1”/sec or 25 mm/sec) and relatively high accel/decel (>40”/sec² or 1000mm/sec²).

**Homing to Limit Switch**

The To Limit Switch homing routine is only available if the Positive or Negative Limit Switch is configured in the I/O tab (see Section 9: I/O Tab). This home routine uses either the positive or negative limit switch to find home position. The ACS Drive initiates an incremental move the size of one stroke length and stops motion when the limit switch input is activated.

NOTE: To ensure repeatability it is best to home with relatively slow velocity (<=1”/sec or 25 mm/sec) and relatively high accel/decel (>40”/sec² or 1000mm/sec²).

### 12.1.2 Direction of Motion

*Positive or Negative:* Depending on the setup of the motor in the Motor tab (see Section 7: Motor Tab), this selection will define the direction the motor/actuator system homes.

### 12.1.3 Motion Profile & Offset

- **Velocity to Hard Stop / Limit Switch:** Velocity used in the initial move towards the hard stop or limit switch.
- **Velocity to Offset:** Velocity used when reversing direction to the Offset.
- **Accel / Decel:** Acceleration and Deceleration setting for all moves in the homing routine.
- **Offset:** Distance to move away from either hard stop or limit switch in the opposite direction selected by Direction of Motion.
- **Force:** Force % setting for all moves in the homing routine.

### 12.1.4 Controls

- **Home:** Initiates the Home sequence.
- **Enabled and Homed:** Status LEDs.
- **Position:** Indicates current position in user units.

### 12.1.5 Additional Settings

- **Automatically Home on Power Up:** This feature homes the system automatically when the ACS Drive unit is powered up.

NOTE: The Enable input must be activated for the home routine to start.

NOTE: This feature will not work when the ACS Drive is in Network mode.
The Mode Setup tab is used for configuring the selected mode in the Mode Select tab (see Section 8: Mode Select Tab).

### 13.1 Index Move Mode

With the Index Move mode, there are three different selections: 4, 8 & 16 Move Commands. If the ACS Drive has not been previously configured or it has been restored to factory defaults, the Move Commands will be configured with zero velocity, accel & decel to prevent any motion. The velocity, accel and decel fields will be highlighted in light indicating they are invalid settings (see table below).

The setup table used for the 4, 8 & 16 Move Commands mode has the following columns: Label, Move Type, Position, Velocity, Accel, Decel and Force. Each individual Move Command (rows) can have different, independent settings for each column.

<table>
<thead>
<tr>
<th>Setup Table Move Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Move Type</td>
</tr>
<tr>
<td>Absolute: Initiates an absolute move upon the Start Motion Input.</td>
</tr>
<tr>
<td>IncrPos: Initiates an incremental move in the positive direction upon the Start Motion Input.</td>
</tr>
<tr>
<td>IncrNeg: Initiates an incremental move in the negative direction upon the Start Motion Input.</td>
</tr>
<tr>
<td>JogPos: Initiates a jog move in the positive direction when the Start Motion Input is active. When the Start Motion Input is not-active motion is stopped.</td>
</tr>
<tr>
<td>JogNeg: Initiates a jog move in the negative direction when the Start Motion Input is active. When the Start Motion Input is not-active motion is stopped.</td>
</tr>
<tr>
<td>Home: Initiates the homing sequence that is defined in the Home Setup tab. The position, velocity, accel/decel and force settings in that row will be disabled (not used) for this move type.</td>
</tr>
<tr>
<td>No Action: Allows user to configure an unused move in the table in order to prevent unintended motion. If this move is executed, the ACS Drive will do nothing. The position, velocity, accel/decel and force settings in that row will be disabled (not used) for this move type.</td>
</tr>
<tr>
<td>NOTE: See Start Motion Input (see Appendix 1: Timing Diagrams)</td>
</tr>
<tr>
<td>Position</td>
</tr>
<tr>
<td>Velocity</td>
</tr>
<tr>
<td>Accel/Decel</td>
</tr>
<tr>
<td>Force %</td>
</tr>
</tbody>
</table>

*Table 13-1: Descriptions of Setup Table Move Definitions for 4, 8, and 16 Move Commands*
Figure 13-1: Mode Setup– 4 Move Commands, Not Configured

Figure 13-2: Mode Setup– 8 Move Commands, Not Configured
NOTE: The software controlled MS# LEDs will light to indicate what digital input pattern corresponds to that row. Similarly, you can use the mouse to click and toggle the MS# LEDs On/Off and the row corresponding to that binary code will be selected.

Figure 13-3: Mode Setup– 16 Move Commands, Not Configured

NOTE: Default Move Command velocities, acceleration, and deceleration are 0. If user does not configure a valid value for all motion parameters the TMI software and the ACS Drive will not allow that move to be executed.

For the move types of Home and No Action the fields for Position, Velocity, Accel, Decel and Force do not apply. They appear grey and are disabled for these move types.

With Home move type the parameters used in the homing routine are from the Home Setup tab. Using a Home move type in the Index Move table allows the user to free up an additional digital input.

The No Action move type is used to prevent unwanted moves from being commanded. If this type is configured, the controller will simply do nothing when it is commanded to move to that move number.

Figure 13-4: Mode Setup– The Home & No Action commands disable several fields.
13.1.2 Editing, Arranging and Testing Move Commands

Once all the Move Commands have been configured, there are several features in the Mode Setup screen for editing, arranging, or testing the configured Move Commands.

**Move Row Up / Down:** Move the Move Commands up and down one row at a time in the table.

**Copy / Paste / Cut Row:** Copy, Paste & Cut functionality for each row. Select the row and click button for desired functionality.

**Teach:** Teach all motion profile parameters (position, velocity, accel/decel, force) from the Motion Manager (see Section 14: Motion Manager Tool) into the selected row in the table. If the selected row already has valid data, the TMI will prompt the user whether they want to overwrite it or not. If the ACS Drive is disabled (See Motion Manager) pressing teach will only update the position (not Velocity/Accel/Decel or Force). This is useful for manually positioning the actuator then teaching that position.

**Execute Move:** Clicking this button will execute or start the selected move in the table. The selected move is denoted by the move highlighted in blue with the black arrow on the left hand side. For Jog moves, the move is initiated while the Execute Move button is pressed and will stop when the Execute Move button is released.

**Motion Manager:** Opens and closes the Motion Manager tool (see Section 14: Motion Manager Tool)

**Write Flash:** Write Current Settings to Drive Flash: Write all parameters from the TMI software into the drive flash memory.
Software Controlled: When the TMI is in Software Control, all motion commands (Start Motion and Home inputs) from the I/O interface (PLC or logic controller) are ignored. In order to test the I/O logic with the PLC or logic controller, the user must select Digital Input Controlled.

While in Software Control, the user can test the moves by using the Software Controlled Move Test Sequence. This feature allows up to 16 Move Commands to be tested in any order. When in Software Controlled mode, the Move Select (MS#) LEDs in the Digital Input Controlled group box will echo the logic of the selected Move Command in the table. The Software Controlled mode feature has the following controls:

![Software Controlled Move Test Sequence](image)

**Add:** Click Add to add a Move Command to the next available position.

**Reset:** Removes all Move Commands from the test sequence

**Play:** Initiates the test sequence. All Move Commands in sequence will be executed once.

**Stop:** Stops the test sequence.

**Pause:** Pauses the test sequence on the highlighted move.

**Step:** Steps through the test sequence one Move Command at a time.

**Cycle Continuously**

Cycle Continuously: When this feature is checked, the test sequence cycles continuously in an endless loop until the Stop or Pause button is clicked, the user switches to the Digital Input Controller, navigates to another tab, or communication is disconnected.

When the test sequence is in progress:

1. All other move controls in Mode Setup and Motion Manager will be disabled.
2. The currently executed move will be highlighted in blue in the table.
Digital Input Controlled:

In order to test the I/O logic with the PLC or logic controller, the user must select Digital Input Controlled. When in this mode, all move buttons in the software are disabled and motion can only be initiated from the logic controller (PLC). The selected move from the Move Select inputs (see Section 9: I/O Tab) will be highlighted in blue in the table below. The Move Select (MS#) LEDs in the Digital Input Controlled group box will echo the logic of the Move Select inputs from the physical I/O interface. In this mode, the PLC or logic controller can select the desired move using the Move Select inputs and initiate motion using the Start Motion input (see Appendix 1: Timing Diagrams).

![Digital Input Controlled](image)

**Figure 13-6: Digital Input Controlled**

**NOTE:** When Software Controlled is selected the MS1 to MS4 “LEDs” will track the selected line in the Move Definitions table.

![Mode Setup Tab](image)

**Figure 13-7: Configured Mode Setup, 16 Move Command Mode**
13.2 Pneumatic Mode

Pneumatic mode is used to replace or mimic pneumatic cylinder/valve operation logic. With pneumatic mode, there are four different selections: Spring, 2 Position (2 input), 3 Position (2 input) & 3 Position (3 input). These four pneumatic mode operations allow just about any pneumatic valve logic to be replaced with the ACS drive. Additionally, in pneumatic mode, the drive will automatically home the actuator upon power up based on the home setup configuration.

The setup table used for pneumatic mode has the following columns:

<table>
<thead>
<tr>
<th>Setup Table Move Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Move Type</td>
</tr>
<tr>
<td>Position</td>
</tr>
<tr>
<td>Velocity</td>
</tr>
<tr>
<td>Accel/Decel</td>
</tr>
<tr>
<td>Force %</td>
</tr>
</tbody>
</table>

Table 13-2: Descriptions of Setup Table Move Definitions for Pneumatic Mode

NOTE: Default Move Command velocities, acceleration, and deceleration are 0. If user does not configure a valid value for all motion parameters the TMI software and the ACS Drive will not allow that move to be executed.

Figure 13-8: Pneumatic, Spring
13: THE MODE SETUP TAB

Figure 13-9: 2 Position (2 input)

Figure 13-10: 3 Position (2 input)

Figure 13-11: 3 Position (3 input)
Digital Input Controlled:

In order to test the I/O logic with the PLC or logic controller, the user must select Digital Input Controlled. When in this mode, all move buttons in the software are disabled and motion can only be initiated from the logic controller (PLC). The selected move from the Move Select inputs (see Section 9: I/O Tab) will be highlighted in blue in the table below. The Move Select (MS#) LEDs in the Digital Input Controlled group box will echo the logic of the Move Select inputs from the physical I/O interface. In this mode, the PLC or logic controller can select the desired move using the Move Select inputs and initiate motion using the Start Motion input (see Appendix 1: Timing Diagrams).

![Digital Input Controlled](image)

Figure 13-12: Digital Input Controlled

**NOTE:** When Software Controlled is selected the MS1 to MS3 “LEDs” will track the selected line in the Move Definitions table.
13.3 Analog Position Mode

13.3.1 Configuring Analog Position Mode

Analog Position mode is used to equate an analog input voltage or current to position. The ACS Drive will convert the analog input to a scaled position range. If the ACS Drive has an analog output installed, the position of the encoder will be scaled to the analog output. If the ACS Drive has not been previously configured for Analog Position mode or has been restored to factory defaults, the Analog Position mode will be configured with zero Min/Max Position, Velocity, Accel/Decel to prevent any motion. The Min/Max Position, Velocity, Accel/Decel fields will be highlighted in light red indicating they are invalid settings (see Figure 13-21 below).

The mode setup for Analog Position mode has the following parameters that must be configured for proper operation.

Min/Max Voltage or Current: The range of Voltage is 0 to 10Vdc and the range of Current is 0 to 20ma.

Min/Max Position: The configured positions that are equated to the Min/Max Voltage or Current setting. The ACS Drive will then linear interpolate the Analog Input and equate it to position based on the Min/Max Voltage or Current settings along with the Min/Max Position settings.

Velocity: Velocity value for any Analog Position move.
Accel/Decel: Acceleration and deceleration value for any Analog Position move

Force: Force % value from 10 to 100% for any Analog Position move

Deadband: Plus / Minus window for Analog Input that is ignored or not used to create motion.

Position Update Rate: This setting adjusts the rate at which position commands are updated based on the changing Analog Input. A slower setting means the response of the system will not be as dynamic. A faster setting means the system will respond more quickly

Figure 13-14: Settings for Analog Position mode for Voltage

Relationship between Analog Mode & Start Motion Input:

1. If Start Motion Input is configured in I/O Tab then user must set the Start Motion input ON to get motion. If Start Motion is configured and is set to OFF, user will not get motion after adjusting analog input.

2. In I/O Tab unmapping Start Motion input relieves the responsibility of setting Start Motion input to get motion using Analog input.

**NOTE:** If the Analog Output option is not installed, the Output slider will not be visible.

**NOTE:** If the motor doesn’t have an encoder, the analog output will be forced
to 0 (volts or mA) and not used.

**NOTE:** In Analog mode Motion Select functions should not be mapped to digital inputs because they have no effect on the motion.

In the example above:

- 0 volts = 0 inch position
- 10 volts = 4 inch position

All moves will move with 3 inch/sec velocity, 10 inch/sec² accel/decel and 100% force.

### 13.3.2 Simulating the Analog Input

To simulate the analog input and test the logic setup for Analog Position mode, click on the Simulate Analog Input checkbox. When this is done, all the Analog Position Setup variables and the calibrate Analog I/O button are disabled because any changes are not allowed when attempting motion. There are two sliders in the Test Analog Position box: one for an input and one for the output. The Input is enabled and the user can change the values of the simulated analog input to create motion. The output slider should mimic the value of the analog output based on the actual position, if the motor has an encoder.

![Figure 13-15: Simulating Analog Input](image)

**NOTE:** When Simulate Analog Input is not checked, the output slider may be moved to manually change the analog output of the ACS drive.
13.3.3 Analog Input Controlled

Analog Input Controlled is used to test the logic of the Analog Position mode setup with actual external hardware such as a PLC. When the Analog Input Controlled button is pressed, the message below will be displayed.

**WARNING:** If “Yes” is selected, the user should expect motion as the ACS Drive will attempt to move in accordance with the Analog Position Setup.

*Figure 13-16: Confirm motion warning window*

Once in this mode, the PLC or external Analog source can be used to test the system.

*Figure 13-17: Analog Input Controlled*

13.3.4 Calibrating Analog Input & Output

For advanced applications where positional accuracy is extremely important, the Analog I/O Calibration tool can be used to calibrate both the Analog Input and Output. Press the Calibrate Analog I/O tool from the Mode Setup screen to launch
the tool. Once in Analog I/O Calibration, the user can not navigate to any other screens in the Tolomatic Motion Interface (TMI). The user must click the Calibrate Analog I/O check box to enable the calibration process.

For analog input calibration, a voltage / current source and a meter (ohm / multi meter) will be required. Input a voltage or current to the ACS Drive and measure with the meter. Enter that value into the Measured Input field and press the associated Calibrate Min or Max button. For voltage, the recommended ranges are 1-4 volts for the Min voltage and 6-10 volts for the Max voltage. For current, the recommended ranges are 2-8 mA for the Min current and 12-20 mA for the Max current.

The analog input also has a software filter that is adjustable to give flexibility to the user on how dynamic the Analog Position control should be. With a filter setting more towards Min, the analog filter will do less filtering and the analog input signal will give the controller more raw data in which to respond. With a filter setting more towards Max, the analog filter will do more filtering causing the analog input signal to the controller to be smoother (less noisy).

For analog output calibration, a meter (ohm / multi meter) will be required. Enter a Min voltage or current (1 - 4 volts or 2 - 8mA) into the Test Output field press Test Min and then measure with the meter. Enter the measured value into the Measured Output field and press Calibrate Min button. Repeat procedure for Max voltage or current (6 - 10 volts or 12 - 20mA) and press the Calibrate Max button.

Figure 13-18: Sample of completed Analog I/O calibration
13.4 Network Mode *(Modbus RTU, EtherNet/IP & Modbus RTU)*

### 13.4.1 Using Network Mode

Once the ACS Drive has been configured for the desired Actuator and Motor, Network mode can be configured for control with Modbus RTU, EtherNet/IP or Modbus TCP protocol. Depending on the model ordered, the TMI software will only show either Modbus RTU, EtherNet/IP or Modbus TCP (also known as Modbus TCP/IP, Modbus/TCP or Modbus-TCP). In this section Network refers to Modbus RTU, EtherNet/IP or Modbus TCP protocols.

When Mode Select is configured for Network operation, the Mode Setup tab will allow setup of up to 16 moves. The Network Move GroupBox displays the most recently commanded move. Please note that the Current Position is displayed instead of the Position from the move table or the position sent over the network. The reason for this is to be able to track the absolute position at all times. Move number 0 indicates a move commanded by the TMI Motion Manager or the Network connection.

When the TMI user presses the Network Controlled radio button, or whenever the Modbus RTU (or EtherNet/IP Modbus TCP or Modbus RTU) client commands a move the Host in control indicator (as seen on the Drive Status Tool) will turn off and the TMI controls will be disabled. This keeps the TMI user from changing parameter values while the Modbus RTU, EtherNet/IP or Modbus TCP client is commanding movement.

![Figure 13-19: Modbus RTU Controlled](image)

or

![Figure 13-20: EtherNet/IP Controlled](image)

or

![Figure 13-21: Modbus TCP Controlled](image)

When Network is in control, the controls in the Mode Setup tab’s Network Move GroupBox show the most recent move commanded by the Modbus RTU, EtherNet/IP or Modbus TCP client. Note that rather than displaying the commanded position, the Current Position is displayed.
To return control to the TMI host, either press the Software Controlled radio button, or select one of the tabs other than Mode Setup.

![Diagram of software in control]

Figure 13-22: Software in control, last commanded move is highlighted.

The Host in control indicator on the Drive Status tool indicates whether TMI (the Host in this case) is in control.

![Diagram of drive status tool]

Figure 13-23: Drive Status tool indicates Software (Host) is in control.
Figure 13-24 EtherNet/IP (or Modbus TCP, Modbus RTU) in control, last commanded move is highlighted.

Figure 13-25: Drive Status tool indicates EtherNet/IP (or Modbus TCP, Modbus RTU) is in control.
<table>
<thead>
<tr>
<th>Relationship between Network Mode (Modbus RTU, EtherNet/IP or Modbus TCP) &amp; I/O:</th>
</tr>
</thead>
<tbody>
<tr>
<td>When user selects Network Mode all digital inputs and digital outputs are set to &quot;Not Configured&quot;. This way PLC or HMI can map any desired condition to them and set/reset digital output accordingly. When not configured, digital inputs don’t have any effect. If user selects Network Mode and maps functions to digital outputs and digital inputs, they behave as follows:</td>
</tr>
<tr>
<td>Enable Digital Input is set to ON and Network command disables the ACS Drive, the ACS Drive remains enabled.</td>
</tr>
<tr>
<td>Enable Digital Input is set to OFF and Network command enables the ACS Drive, the ACS Drive becomes enabled</td>
</tr>
<tr>
<td>If E-Stop Input is wired to digital input, configured in TMI and E-Stop input is ON, the ACS Drive will not move even if motion is commanded over Network.</td>
</tr>
</tbody>
</table>

**NOTE:** In Network Mode motion select functions should not be mapped to digital inputs because they have no effect on the motion.
14.1 Using the Motion Manager

The Motion Manager allows the user to enable/disable the motor, home, and create simple motion commands (Absolute, Incremental, Jog). The Motion Manager is a good tool to use for positioning in order to teach Moves into the Mode Setup table (see Section 13: Mode Setup Tab).

14.1.1 Controls

*Enable/Disable*: Enables or Disables drive and output to motor.

*Home*: Initiates Home sequence configured in Home Setup Tab.

*Enabled, Homed, Motion Complete LEDs*: Status LEDs.

14.1.2 Motion Profile

*Position*: Displays actual position from encoder or commanded position without encoder. Motion profile (Velocity, Accel, Decel, Force) per Jog, Absolute and Incremental moves in Motion Manager.

14.1.3 Jog

*Jog Neg*: Initiates a Jog Move with motion profile settings in a negative direction.

*Jog Pos*: Initiates a Jog Move with motion profile settings in a positive direction.

**NOTE**: Jog move will be initiated while Jog Neg or Jog Pos button is held down by mouse click. The jog move will stop when the mouse click is released.
14.1.4 Absolute Move
Initiates an absolute move to entered position parameter with motion profile settings.

14.1.5 Incremental Move

*Incr Neg:* Initiates an incremental move the size of the entered distance parameter in a negative direction.

*Incr Pos:* Initiates an incremental move the size of the entered distance parameter in a positive direction.
15.1 Using the Digital I/O Tool

The Digital I/O tool is launched from the Tools Menu in the TMI interface menu bar or the Tool Bar. This tool shows the current status of the physical I/O interface. The description of each input and output is dependent on the I/O configuration from the I/O Tab (see Section 9: I/O Tab)

![Figure 15-1: Launching the Digital I/O Tool](image1)

![Figure 15-2: Digital I/O Tool](image2)
16.1 Using the Analog I/O Tool

The Analog I/O tool is launched from the Tools Menu in the TMI interface menu bar or the Tool Bar. This tool shows the current status of the physical Analog I/O interface. The units will be Volts or mAmps as determined by the Analog Position Settings (see Mode Select tab Section 8.1)

![Figure 16-1: Launching the Analog I/O Tool](image1)

![Figure 16-2: Analog I/O Tool](image2)
17.1 Using the Drive Status Tool

The Drive Status Tool is launched from the Tools Menu in the TMI interface menu bar or the Tool Bar. This tool shows the current status of critical information about the drive.
18.1 Using the Network Setup Tool

Choose the Tools -> Network menu selection or press the Configure Network button in the toolstrip.

![Network Settings](image1)

Figure 18-1: Ready to manually enter the IP address

Enter the IP address, Subnet Mask and Default Gateway parameters for the network. (The values shown above are the factory default values for the ACS drive. Typically, at least the IP address and Default Gateway will need to be changed for the network.) Settings are downloaded when OK is pressed.

To test the Network settings, the Test button can be used to download the Network settings to the ACS drive and when the Test button is pressed, TMI will download the settings to the ACS drive and initiate the PC to Ping the drive. This ping test only works if the PC running TMI is connected via Network to the ACS Drive (in addition to the RS-232 connection required by TMI).

NOTE: An Ethernet cable must be connected from the PC to the ACS drive.

![Network Settings](image2)

Figure 18-2: A manually entered IP address, ready to test
If the Test worked, a screen will pop-up showing similar results to the following.

![Ethernet Connection Test](image)

**Figure 18-3: Testing verifies a successful Network connection**

If the Test didn’t work (in this example, the Ethernet cable was unplugged from the ACS drive) an error dialog will be shown.

![Ethernet Connection Test](image)

**Figure 18-4: Testing indicates a failed attempt for Network connection**

To configure the ACS drive for DHCP server in order to dynamically assign an IP Address:

- check the “Obtain an IP address automatically” checkbox
- click OK on the ACS Internet Protocol (TCP/IP) Properties dialog
- click the Disconnect button on the TMI Drive tab (or press the Disconnect from Drive button on the toolstrip)
- click Yes when asked “Update drive flash memory?”.  
- cycle ACS drive power (turn off then turn on)  
- press the Connect button on the TMI Drive tab (or press the Connect to Drive button on the toolstrip)

When the Network configuration tool is opened, the status bar informs the status of the DHCP address configuration process. This is not dynamically updated. To see the current status, press Cancel (or OK), wait a bit, then open this tool again.
Figure 18-5: Obtaining an IP address automatically

If there is a problem and the ACS drive is unable to get an IP address from the DHCP server, the status bar will display the error message in the status bar.

Figure 18-5: Click OK when Network configuration is complete

When Network configuration is complete, press OK.
19.1 Using Ethernet Advanced Diagnostics

When the 36043175ED*.hex (EtherNet/IP) or 36043176MD*.hex (Modbus RTU) firmware is loaded, TMI will display Ethernet MIB Counters in Tools > Advanced Diagnostics Menu.

![Figure 19-1: Advanced Diagnostics pull-down](image)

**Management Information Base (MIB) Counters**

The ACS Drive provides 30 MIB counters per port. These counters are used to monitor the port activity for network management. Counters are polled every 10 seconds while the dialog box in Figure 19-2 is visible. When closed, polling stops. Pink highlighted text box indicates a problem reading the counter (this should rarely occur). Bold numbers indicate a change since previous poll. Use the box in the lower left corner to choose either Port 1 or Port 2: this corresponds to ACS Ethernet Port 1 and Port 2.

![Figure 19-2: Ethernet MIB Counters](image)
### ACS Ethernet Drive MIB Counters

<table>
<thead>
<tr>
<th>TMI Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TxOctets</td>
<td>Tx lo-priority good octet count including PAUSE packets</td>
</tr>
<tr>
<td>Tx Dropped Packets</td>
<td>TX packets dropped due to lack of resources</td>
</tr>
<tr>
<td>TxBroadcastPackets</td>
<td>Tx good broadcast packets (not including error broadcast or valid multicast packets)</td>
</tr>
<tr>
<td>TxMulticastPackets</td>
<td>Tx good multicast packets (not including error multicast or valid broadcast packets)</td>
</tr>
<tr>
<td>TxUnicastPackets</td>
<td>Tx good unicast packets</td>
</tr>
<tr>
<td>TxCollisions</td>
<td>Tx total collision, half duplex only</td>
</tr>
<tr>
<td>TxSingleCollisions</td>
<td>Successfully Tx frames on a port for which Tx is inhibited by exactly one collision</td>
</tr>
<tr>
<td>TxMultipleCollisions</td>
<td>Successfully Tx frames on a port for which Tx is inhibited by more than one collision</td>
</tr>
<tr>
<td>TxDelay</td>
<td>Tx packets by a port for which the 1st Tx attempt is delayed due to the busy medium</td>
</tr>
<tr>
<td>TxLateCollisions</td>
<td>The number of times a collision is detected later than 512 bit-times into the Tx of a packet</td>
</tr>
<tr>
<td>TxEccessive</td>
<td>A count of frames for which Tx fails due to excessive collisions</td>
</tr>
<tr>
<td>TxPausePackets</td>
<td>Number of PAUSE frames transmitted by a port</td>
</tr>
<tr>
<td>RxOctets</td>
<td>Rx lo-priority (default) octet count including bad packets</td>
</tr>
<tr>
<td>Rx Dropped Packets</td>
<td>RX packets dropped due to lack of resources</td>
</tr>
<tr>
<td>RxBroadcastPackets</td>
<td>Rx good broadcast packets (not including error broadcast packets or valid multicast packets)</td>
</tr>
<tr>
<td>RxMulticastPackets</td>
<td>Rx good multicast packets (not including MAC control frames, error multicast packets or valid broadcast packets)</td>
</tr>
<tr>
<td>RxUnicastPackets</td>
<td>Rx good unicast packets</td>
</tr>
<tr>
<td>RxUndersizePackets</td>
<td>Rx undersize packets w/ good CRC</td>
</tr>
<tr>
<td>RxOversizePackets</td>
<td>Rx oversize packets w/ good CRC (max: 1536 or 1522 bytes)</td>
</tr>
<tr>
<td>RxJabbers</td>
<td>Rx packets longer than 1522 bytes w/ either CRC errors, alignment errors or symbol errors (depends on max packet size setting)</td>
</tr>
<tr>
<td>RxAlignmentErrors</td>
<td>Rx packets within (64, 1522) bytes w/ a non-integral number of bytes and a bad CRC (upper limit depends on max packet size setting)</td>
</tr>
<tr>
<td>RxCRCErrors</td>
<td>Rx packets within (64, 1522) bytes w/ an integral number of bytes and a bad CRC (upper limit depends on max packet size setting)</td>
</tr>
<tr>
<td>RxPausePackets</td>
<td>Number of PAUSE frames received by a port. Pause frame is qualified with EtherType (88-0xh), DA, control opcode (00-01), data length (64B min), and a valid CRC</td>
</tr>
<tr>
<td>RxSymbolErrors</td>
<td>Rx packets w/ invalid data symbol and legal packet size.</td>
</tr>
<tr>
<td>64Packets</td>
<td>Total Rx packets (bad packets included) that were 64 octets in length</td>
</tr>
<tr>
<td>65to127Packets</td>
<td>Total Rx packets (bad packets included) that were between 65 and 127 octets in length</td>
</tr>
<tr>
<td>128to255Packets</td>
<td>Total Rx packets (bad packets included) that were between 128 and 255 octets in length</td>
</tr>
<tr>
<td>256to511Packets</td>
<td>Total Rx packets (bad packets included) that were between 256 and 511 octets in length</td>
</tr>
<tr>
<td>512to1023Packets</td>
<td>Total Rx packets (bad packets included) that were between 512 and 1023 octets in length</td>
</tr>
<tr>
<td>1024to1522Packets</td>
<td>Total Rx packets (bad packets included) that were between 1024 and 1522 octets in length (upper limit depends on max packet size setting)</td>
</tr>
</tbody>
</table>

*Table 19-1: ACS Ethernet Drive MIB counters*
Timing Diagrams

The opto-isolated digital inputs require a minimum of 2ms of time to guarantee that the input signal is registered by the drive. This is an important consideration to take into account, especially if limit switches are used. If limit switches are used, careful consideration should be used to prevent missed triggering due to high velocities. Output timing assumes 10 K Ohm load.

INPUT

2ms min

INPUT REQUIREMENT

OUTPUT

SYSTEM

STATUS

5.3s max

POWER-ON TIMING- WITH AUTO-HOME ON POWER-UP:

INPUT

MAIN POWER

SYSTEM STATUS

SYSTEM STARTUP

SYSTEM READY

OUTPUT

MOTION COMPLETE

OUTPUT

SYSTEM READY

2ms max

Figure A1-1 Input Requirement

Figure A1-2 System Startup Timing

INPUT

E-STOP

ENABLE

START MOTION

MOTION SELECT LINES

OUTPUT

MOTION COMPLETE

OUTPUT

MOTION COMPLETE

2ms min

2ms max

2ms min

10ms min

2ms max

2ms min

2ms max

Figure A1-3 Jog Move Timing
PNEUMATIC MODE TIMING

Timing Rules

1. While the Motion Complete signal is low, the drive will ignore Start Motion pulses and Motion Selection lines.
2. If the enable signal is low or E-stop signal is high, the drive will ignore start motion pulses.
Appendix 2

Index Move Mode - Move Select Logic Table

The three operating modes, 4/8/16 move commands, require digital inputs to select the desired move for execution. The digital inputs are called Move Select 1 through 4 (MS1-MS4) in the digital input map. To select the desired move command refer to the three logic tables below.

**NOTE 1:** MS# stands for Move Select #

**NOTE 2:** 1 = On; 0 = Off

<table>
<thead>
<tr>
<th>4 Move Commands Mode Logic Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOVE</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
</tbody>
</table>

*Table A2-1: 4 Move Commands Mode Logic*

<table>
<thead>
<tr>
<th>8 Move Commands Mode Logic Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOVE</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
</tbody>
</table>

*Table A2-2: 8 Move Commands Mode Logic*
## Appendix 2

**16 Move Commands Mode Logic Table**

<table>
<thead>
<tr>
<th>MOVE</th>
<th>MS1</th>
<th>MS2</th>
<th>MS3</th>
<th>MS4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>11</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>13</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Table A2-3: 16 Move Commands Mode Logic*
Pneumatic Mode - Move Select Logic Table

The pneumatic mode requires digital inputs to select the desired move for execution. The digital inputs are called Move Select 1 through Move Select 3 (MS1-MS3) in the digital input map. To select the desired move refer to the four logic tables below.

**NOTE 1:** MS# stands for Move Select #

**NOTE 2:** 1 = On; 0 = Off

### 2 Position (1 input) Table

<table>
<thead>
<tr>
<th>ACTION</th>
<th>MS1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pos 1</td>
<td>0</td>
</tr>
<tr>
<td>Pos 2</td>
<td>1</td>
</tr>
</tbody>
</table>

*Table A3-1: 2 Position (1 input) Mode Logic*

### 2 Position (2 input) Table

<table>
<thead>
<tr>
<th>ACTION</th>
<th>MS1</th>
<th>MS2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pos 1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Pos 2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Current Pos</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Table A3-2: 2 Position (2 input) Mode Logic*

### 3 Position (2 input) Table

<table>
<thead>
<tr>
<th>ACTION</th>
<th>MS1</th>
<th>MS2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pos 1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Pos 2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Pos 3</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Table A3-3: 3 Position (2 input) Mode Logic*
### 3 Position (3 input) Table

<table>
<thead>
<tr>
<th>ACTION</th>
<th>MS1</th>
<th>MS2</th>
<th>MS3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pos 1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pos 2</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Pos 3</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Current Pos Command</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Current Pos Command</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Current Pos Command</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Current Pos Command</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Table A3-4: 3 Position (3 input) Mode Logic

**NOTE:** If logic selects Current Pos Command, then the controller will continue to current commanded position. If already in position, no motion will occur.
Appendix 4

Tolomatic Firmware Upgrade Tool

**SAFETY WARNING:** Disconnect the drive from actuator, motor & encoder before upgrading firmware. Only use Tolomatic authorized firmware to upgrade your ACS drive. Running unauthorized firmware on the ACS drive will result in unexpected behavior.

### A4.2.1 Installation Instructions

#### A4.2.1.1 Installing from the Tolomatic CD

1. Insert the software CD supplied by Tolomatic into the CD-ROM drive in your PC.
2. Follow the link on the displayed web page to install the latest software and view the manuals (requires internet connection)
3. If internet connection is not available, browse the CD and double-click the "**TolomaticMotionInterface[version].exe**" file to run the installer.
4. Follow the prompts to install the software. The installer automatically installs the Tolomatic Firmware Upgrade Tool and appropriate ACS Drive .hex files.

The software will install a program launch icon in the Windows® Start menu at:

**Start > All Programs > Tolomatic > TolomaticMotionInterface[version] > TolomaticFirmwareUpgradeTool**

In the Start menu the program will start with single click.

#### A4.2.1.2 Downloading and Installing from the Tolomatic Web Site at www.tolomatic.com

The Tolomatic Motion Interface can be downloaded from the Tolomatic web site at www.tolomatic.com

1. To download, click on "**Product Resources**" in the navigation bar at top. Select "**Electric Linear Motion**" from the "**Choose a Product Line:**" drop-down list and select "**Software**" from the "**Choose a Resource Type:**" drop-down listing.
2. Select the Tolomatic Firmware Upgrade Tool software from the listing and save the file when prompted to your hard drive.
3. Double-click the "**TolomaticMotionInterface.exe**" file to run the installer.
4. Follow the prompts to install the software. The installer automatically installs the Tolomatic Firmware Upgrade Tool and appropriate ACS Drive .hex files.

The software will install a program launch icon in the Windows® Start menu at:

**Start > All Programs > Tolomatic > TolomaticMotionInterface[version] > TolomaticFirmwareUpgradeTool**

In the Start menu the program will start
A4.3.1 Saving Current Drive Settings

After successful firmware upgrade, the Tolomatic Firmware Upgrade Tool will restore the drive to factory settings appropriate to the new version of firmware, overwriting any user defined settings.

If you run the Tolomatic Motion Interface, connect to the drive and select the File->Save As menu item, you can save the current drive settings to a file. The next time you run Tolomatic Motion Interface after upgrading the drive firmware, you can select File->Open and open this file. The parameter settings in the file will automatically be programmed into the Tolomatic drive.

A4.4.1 Launching the Upgrade Tool Software

1. Double-click the program icon on the desktop or in the Windows® Start menu at: Start > All Programs > Tolomatic > TolomaticMotionInterface[version] > TolomaticFirmwareUpgradeTool to launch the software.

A4.5.1 Upgrading Tolomatic Drive Firmware

Upon startup, the upgrade tool window (Figure A3-1: Initial Upgrade Tool Window) will have default values for Baud Rate and Hex File (a copy of the Tolomatic drive firmware is included with the installer for this application). Click on the COM Port list control for a list of available COM ports and choose the appropriate entry.
Figure A4-2: Initial Upgrade Tool Window

If Tolomatic has provided an alternate file to download, press Browse… and navigate to that file.

Press the Program button to initiate the firmware download process.

Status messages will be displayed (with a % complete progress) at the bottom of the Upgrade Tool window throughout the download process, which should take about 30 seconds (at 38400 baud).

When the firmware download is complete, the Upgrade Tool will boot the drive and force the drive to factory settings.

Figure A4-3: Displaying Version and Restoring to Factory Settings

Figure A4-4: Programming Complete Upgrade Tool window throughout the download process, which should take about 30 seconds (at 38400 baud)
A4.6.1 User Interface Changes – TMI/TFUT 2.2

Significant changes have been made to the Tolomatic Firmware Upgrade Tool (TFUT) to improve usability and robustness.

Figure A4-5 Updated interface

- As in TMI, setting COM Port to Auto will request TFUT to scan available ports looking for an ACS drive and automatically select that COM port. If the ACS drive does not have valid ACS firmware, the COM port must be selected manually.
- Status and progress messages are displayed in the read-only text box.
- Flash baud rates of 19200, 38400, 57600, 115200 (default) and 230400 are supported.
- A Show ACS Drive Info button is provided to query the Product Name, Model, Firmware Version, and Drive Name. This is useful in conjunction with COM Port: Auto. [Note that the ACS firmware always communicates at 38400 baud – the firmware flash speed is configurable]

Figure A4-6 Connected to ACS Drive
A Reset Drive button allows the ACS drive to be rest via the RS-232 connection.
If no Hex File is specified, pressing Program will run a connection test (useful for troubleshooting only)
A progress bar shows how the firmware flashing process is progressing

Figure A4-7: Firmware Flashing Progress

Figure A4-8: Firmware Flashing Complete
A4.7 Tolomatic Motion Interface (TMI)

A4.7.1 TFUT Integrated with TMI

In addition to being available as a stand-alone tool, the Tolomatic Firmware Upgrade Tool (TFUT) is now available from TMI. Selecting this menu item will cause TMI to disconnect from the ACS drive (discarding any changes) and open a modal TFUT dialog.